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Abstract

Restricted, repetitive behaviors (RRBs) are a core feature of autism spectrum disorder (ASD) and disrupt the lives of affected individuals. RRBs
are commonly split into lower-order and higher-order components, with lower order RRBs consisting of motor stereotypies and higher order
RRBs consisting of perseverative and sequencing behaviors. Higher order RRBs are challenging to model in mice. Current assays for RRBs in
mice focus primarily on the lower order components, making basic biomedical research into potential treatments or interventions for higher-order
RRBs difficult. Here we describe a new assay, novel object exploration. This assay uses a basic open-field arena with four novel objects placed
around the perimeter. The test mouse is allowed to freely explore the arena and the order in which the mouse investigates the novel objects
is recorded. From these data, patterned sequences of exploration can be identified, as can the most preferred object for each mouse. The
representative data shared here and past results using the novel object exploration assay illustrate that inbred mouse strains do demonstrate
different behavior in this assay and that strains with elevated lower order RRBs also show elevated patterned behavior. As such, the novel
object exploration assay appears to possess good face validity for higher order RRBs in humans and may be a valuable assay for future studies
investigating novel therapeutics for ASD.

Video Link

The video component of this article can be found at https://www.jove.com/video/54324/

Introduction

Autism spectrum disorder (ASD) is a neurodevelopmental disorder consisting of three core symptoms: social impairment, difficulty
communicating through language, and repetitive patterned behaviors1. Since 2000, the number of individuals who have been diagnosed with
ASD has increased from 1 in 150 to 1 in 68 in the span of ten years 2. Though the prevalence of the disorder continues to increase, the cause
of the disorder is not yet known. There has been a rise in efforts to identify appropriate mouse models for the core and associated symptoms
of ASD, as these models could lead to an increased understanding of the underlying symptoms and causes of ASD. There are multiple inbred
mouse strains that appear to display behaviors with face validity for the core symptoms of ASD, including repetitive behaviors3.

Restricted, repetitive behaviors (RRBs) are a core symptom of some psychiatric disorders such as ASD. RRBs can increase with the severity
of the disorder4, and can drastically disrupt the lifestyle of affected individuals. RRBs are commonly placed into two categories, lower-order
repetitive behaviors, which in humans consist of actions such as rocking and hand-flapping; and higher-order repetitive behaviors, which consist
of strict adherence to routine and resistance to change5-8.

Lower-order repetitive behaviors have been widely studied in rodents where they manifest as motor stereotypies, which can be easily observed
in a laboratory setting9. These behaviors appear to have good face validity for RRBs in humans, and potentially strong construct validity as
well10. Testing for the presence of lower order RRBs can be completed through video monitoring of mouse activity to study the bouts and
duration of these motor stereotypies11. Higher order repetitive behaviors pose a challenge for basic biomedical research utilizing rodents, as
these RRBs are not as easily identified through simple observation. Due to the difficulty in identifying these behaviors, fewer established assays
for higher-order repetitive behavior exist. Traditionally, higher-order RRBs have been measured in rodents using a maze paradigm where the
test animal is trained to reach competency in escaping. The escape location is then switched and the number of trials required to re-learn the
escape location is recorded12. These assays are not ideal as they require a lengthy training period, often induce anxiety, and can result in highly
variable results. Hole-board exploration has also been used to quantify higher-order RRBs13,14. This approach does not require extended training
sessions, but does rely on food motivation and/or olfactory discrimination. Assays for higher order RRBs that are not anxiogenic or require
training would be a nice complement to the existing repertoire of hole-board exploration and maze-based assays currently in use.

The C58/J (C58) inbred mouse strain strongly exemplifies high levels of stereotypic behavior associated with ASD, namely repetitive,
purposeless motor stereotypies and elevated levels of self-grooming3,11. Additionally, the C58 mice display RRBs through high levels of rearing,
back flipping and scrabbling11,14,16. This strain begins showing these behaviors early in the neonatal period and continues to display them
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throughout adulthood.  It would be ideal to be able to test for the presence of elevated higher-order RRBs to complement the well-documented
lower order RRBs present in this strain as well as other mouse strains.  The novel object exploration assay described here provides the
opportunity for researchers to observe lower-order and higher-order RRBs simultaneously, as it gives the ability to measure patterned behaviors
as well as repetitive motor stereotypies.

Using novel object exploration as an assay for higher-order repetitive behaviors was developed by Pearson et al.17. This new assessment is an
extension of the well-established open field test18-21 with the addition of four novel objects to the arena. Mice were allowed to freely investigate
these unfamiliar objects and the number and order of object investigations was tracked. The object investigations were then analyzed for the
presence of patterns, with BTBR mice displaying elevated numbers of patterned investigations among the objects. Using this assay, mice
can display higher-order repetitive and patterned behaviors while eliminating the need to learn behaviors as well as removing unnecessary
stimuli. Novel object exploration induces higher-order RRBs, as it allows the mice to create patterns and form sequences through their natural
exploration. Using this assay allows the investigator to quantify the presence of these higher-order RRBs.

Pearson et al. developed this assay and used it to test for the presence of potential higher order repetitive behaviors in the BTBR inbred mouse
strain, with intriguing results17. We have recently published a follow-up study looking at the behaviors of the C58, C57BL/6J (C57) and FVB/
NJ (FVB) strains, as well as a more detailed investigation into potential confounding variables present in this assay, and possible statistical
approaches to analyzing the data generated22.

Protocol

The protocol described here was approved by the Institutional Animal Care and Use Committee at the University of Redlands. The C58, C57, and
FVB mice used in these studies were bred at the University of Redlands vivarium from stock originally obtained from the Jackson Laboratory (Bar
Harbor, ME).  Sentinels from this vivarium were screened every six months and found to be pathogen free.

1. Equipment and Room Set Up

Note: We used two different arenas for novel object testing: a clear plastic rectangular cage (45 cm x 24 cm x 20 cm) or an opaque circular cage
with a base diameter of 41 cm; however, any cage may be used. Pearson et al. used a smaller rectangular cage (20 cm x 30 cm x 20 cm) in their
assay. Details from this specific experimental design are included below, but given the novelty of this assay, there is no accepted standards within
the field of behavioral phenotyping for any of the variables described. 

1. Fill the testing arena with approximately ½ in of corn-cob bedding.
2. Select four different novel objects. Select four objects that are approximately the same size, constructed of high density plastic to facilitate

cleaning and resist chewing and different from each other in shape and color. Importantly, ensure that test mice are not exposed to these
objects until being run in the assay.
 

Note: For example, a pink toy brick, a red monkey, a white tile with blue writing and a standard white die were used here.
3. In the rectangular arena, place these objects approximately 3 cm from the corners. In the round arena, place the objects such that they are

at equal distances from each other and approximately 10 cm from the sides. Record the placement of each object as a different number, 1-4
(Figure 1). Ensure that the objects are placed in a random or counterbalanced order throughout testing.

4. Position a camera directly above the testing arena to record the entire arena during the acclimation and test periods.
 

Note: Having investigators in the same room with the mice can potentially influence activity levels and exploration during testing.

2. Novel Object Exploration Test

1. Test at the beginning of the light cycle in a room illuminated with fluorescent lighting at approximately 100 lux. Ensure that lighting is uniform
across the testing arena to standardize appearance while video recording.

2. Place a notecard of known dimensions in the bottom of the testing arena and begin video recording.
3. Transfer the test mouse into an empty testing arena for 10 min to serve as an acclimation period. Video record the acclimation period.
4. After the acclimation period, leave the mouse in the arena, quickly add the four novel objects to the test arena and record the mouse behavior

for an additional 10 min.
5. Once the full 20 min acclimation/testing period has elapsed, return the test mouse to its home cage and thoroughly clean and dry the novel

objects and testing arena with unscented dish soap and water.

3. Video Scoring

1. Complete all behavior scoring using video to facilitate reliability.
 

Note: The behavioral logging software Noldus The Observer was used to perform the steps22 as described here, but a specialized program is
not necessary:

1. Prior to scoring the first video, set up the project coding scheme in the behavioral logging software by creating a new project or by
editing an existing, similar project.

1. Within the Project Setup box, set data acquisition to 'Offline Observation.' Within the Behavior Coding box, program "Scrabble",
"Digging", "Rearing", "Grooming" and "Sniff Object 1, 2, 3 and 4" as 'State Events'. Program "Jumping" as a 'Point Event'. Note:
Definitions for these behaviors are described in detail elsewhere11.
 

Note: State Events have a start and stop time, whereas Point Events simply collect count data. The keystrokes for each discrete
behavior are generated by the software and these corresponding keystrokes are programmed into a secondary keyboard (step
3.1.2).
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2. To program the secondary keyboard, open the keyboard software, click on the appropriate secondary keyboard button
displayed on the screen, type in the appropriate keystroke combination, and click OK. Once the secondary keyboard has been
programmed, close the software as the program will run in the background of the computer.

2. Once the project and has been set up, use the behavioral logging software to score the number and duration of rears (defined as both
front paws being placed on a wall of the arena), digs (defined as two front paws of the mouse burrowing into the bedding of the arena),
self-grooms (defined as the mouse licking any region of their own body and/or the mouse touching any part of the face with their front
paws), and jumps (defined as a mouse rearing and then jumping so that all four feet are off the ground simultaneously).

1. To score a video, go to File > Open Project and then Observe > Observation > New. The program prompts for a file name. Once
named, select the appropriate video media file.

2. Begin the scoring by clicking on the Begin Observation button.
 

Note: When scoring mouse repetitive behavior, all State Events require two keystrokes, the first corresponding to the initiation of
the behavior and the second corresponding to the end of the behavior. Point Events only require one keystroke.

3. Score the number of times the mouse sniffed each object. Sniffs are defined as any time a mouse moves its nose within 0.5 cm of an
object. Measure sniff duration using behavioral logging software in the same way that repetitive behavior durations were measured
(step 3.1.2).

1. Every time a mouse sniffs an object, record the corresponding position number, which will lead to a string of numbers by the end
of the 10 min testing period (e.g. 1243421…). Manually record these data.
 

Note: To facilitate efficiency and consistency while scoring videos, the numbers always correspond to a given position, not object.
2. If a mouse sniffs an object, looks away, then sniffs the object again, count that number twice.
3. Once the full 10 min video has been scored, visualize the data by clicking on Analyze > Behavior Analysis > New. Once the data

appear on the screen, export or copy and paste into a separate spreadsheet.

4. Record the total distance the mouse traveled within the arena during testing.
 

Note: The video tracking software, calibrated to track the test mouse and record the total distance moved in centimeters, was used to
perform this step. All videos scored by the video tracking software had a notecard of known dimensions placed in the arena at the start
of the video.

1. Use the notecard to calibrate each video within the software by setting a calibration line along each end of the notecard and
inputting the appropriate length within the software's calibration screen. Once the lines are drawn, input the known length and
width of the notecard that correspond to each line.

2. Within Arena Settings, select the entire arena.
 

Note: Separate areas of the arena can be differentiated in the software if, for e.g., mouse movement along the walls vs. through
the center was of interest.

3. Within Trial Control Settings, select a ten-minute duration. In Detection Settings, choose a dark object on a light background.
 

Note: This would need to be changed if albino mice were being used or if the background was a darker shade.
4. Once the settings have been programmed, score the videos. Click Acquisition > Open Acquisition. In the Acquisition Control box,

click New Trial and then Start Trial. After ten minutes has elapsed, the program stops and the data can be visualized.
5. Click Analyze > Calculate Statistics. Once the data appear on the screen, export or copy and paste into a separate spreadsheet.

4. Statistical Analyses, Sequencing

1. Within the string of numbers corresponding to object investigations generated by each mouse, identify the total number of all possible 3 digit
combinations without repeat numbers (e.g. 121, 123, 124 but not 112 or 122).
 

Note: A program written in Python programming language was used to identify the number of times each possible sequence appears in the
string of numbers. It is not necessary to use an outside program, and this step could be completed many different ways (e.g. using a Find
function in Microsoft Word or Excel).

2. Record the number of times each sequence occurs and identify the three most often repeated sequences for each mouse.
 

Note: Individual sequences will vary by mouse and the actual sequence is of less interest than the number of times a sequence was repeated
(i.e. adherence to a pattern is more important than the pattern itself).

3. Because the total number of sequences a mouse repeats will correlate positively to activity level, correct these values by dividing the
quantity of most frequent patterns by the total number of patterns for each individual mouse. This will yield a sequence repeat index that is
independent of overall activity.

4. Compare the number of times each mouse repeats its most common sequences (corrected for activity level) between groups using an
appropriate ANOVA, multiple comparison procedure (Dunnett's test, for e.g.) and post-hoc tests.

5. Statistical Analyses, Object Preference

1. Using the same string of numbers generated above (step 3.1.3.1), identify the novel object preference of each mouse by counting the total
number of times each object was investigated, or in other words, counting the total number of 1 sec, 2 sec, 3 sec, and 4 sec in the string of
data. Correct for activity level and compare via ANOVA as described above (steps 4.3-4.4).
 

Note: These methods published by our lab22 and described here are based heavily on Pearson et al.17
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Representative Results

The representative data22 show that female C58/J mice displayed a higher number of sequenced patterns than the other strains in the round
arena (Figure 2, panel A), but not in the rectangular arena (Figure 2, panel C). None of the three male strains differed from each other (Figure
2, panels B and D). The representative data show that both male and female C58/J mice display a stronger preference for their most visited
object (and subsequently, a lower preference for their least visited object) in the round arena (Figure 3, panel A and C) but not in the rectangular
arena (Figure 3, panel B and D).

 

Figure 1: Rectangular and Circular Arena Set-up for Novel Object Testing. The numbers represent the position of each object, which were
randomly assigned for each mouse. This figure has been modified from reference22. Please click here to view a larger version of this figure.
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Figure 2: Representative Data Illustrating the Number of Times the Three Most Common 3-pattern Sequences were Repeated, Taken
as a Percentage of the Total Number of Patterns in Three Inbred Mouse Strains. The C58 females displayed a strong adherence to their
preferred investigatory patterns in the round arena (A) but not the rectangular arena (C). The three strains of male mice did not differ from each
other in either the round (B) or rectangular (D) arenas. The data are expressed as mean + standard error of the mean * p <0.05 vs. C57 and FVB
** p <0.01 vs. C57 and FVB. This figure has been modified from reference22. Please click here to view a larger version of this figure.

 

Figure 3: Representative Data Illustrating the Preference for Individual Novel Objects in Three Inbred Mouse Strains. The data are
displayed as a percentage of total object investigations, with Choice 1 representing the most preferred object for each individual mouse and
Choice 4 the least preferred object. Male (A) and female (B) C58 mice in the round arena showed a stronger preference for their most preferred
object than did the other two strains. Male (C) and female (D) mice showed no strain differences for object preference in the rectangular arena.
The data are expressed as mean + standard error of the mean * p <0.05 vs. C57 and FVB # p <0.05 vs. FVB. This figure has been modified from
reference22. Please click here to view a larger version of this figure.

Supplemental Code File: Python Equivalent Code. Please click here to run the program.

Discussion

Here, we present a recently developed assay that may be useful for quantifying mouse behaviors with face validity for higher order repetitive
behaviors in humans. Unlike more established assays like the Barnes or T-maze, this novel object exploration assay does not require any
mouse training nor is it particularly anxiety provoking. Additionally, novel object exploration does not require any food or social stimuli, allowing
for more focus on the behaviors of interest, RRBs, and decreasing the likelihood of confounding variables skewing the results. Furthermore,
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different mouse strains do demonstrate differential behavior in this assay, with strains demonstrating elevated lower order RRBs also showing
elevated patterned exploration and object preference in the novel object exploration assay17,22. As such, this assay appears to possess good
face validity to RRBs in humans. If the assay is modified by future researchers, it would be beneficial to remain mindful of the advantages listed
above, namely the lack of training required and the minimization of anxiety-inducing stimuli. Selection of the novel objects (Section 1.2) used
in the assay is vital. The objects should be easy to clean, but be distinct in appearance and similar in size. Using a camera to record the assay
(Section 1.4) and allowing the mice to acclimate to the testing arena (Section 2.3) are also vital, as the novelty of the arena or the presence of an
experimenter in the room can impact the behavior of the mice. These are critical aspects of the protocol described here.

Despite these advantages, there are other factors that should be considered when deciding upon an appropriate assay for higher order RRBs.
The primary challenge in analyzing the data generated by this assay is the correlation to activity levels, which can differ vastly between different
mouse strains23,24. One possible way of controlling for differing activity levels among comparison groups was discussed; there may be other
more appropriate or elegant solutions to consider either with experimental design or statistical analysis. Carefully choosing control strains with
similar activity levels as the strain of interest is one possibility. Alternately, statistical analysis on only a subset of the data (the first 50 novel
object investigations, for example) is another possibility.

Although this assay is not inherently anxiety inducing, the natural anxiety levels of each different strain may lead to differences in collected
results. Highly anxious mice typically prefer to move along the walls and corners of an open field arena23,25 and if the novel objects in this
assay are placed to close to the edges or corners, artificially high novel object investigations may be recorded in anxious strains. We attempted
to correct for this confounding variable by using a round testing arena and moving the objects away from the walls, in addition to using a 10
min acclimation period prior to testing. Other potential corrections could be to test under darkened conditions, in the mouse's home cage or
by varying the acclimation time. Anxiety could be quantified within the novel object exploration data itself by measuring the latency to the first
investigation as well as by measuring the number of repeated investigation of the same object without interruption.

Vision and olfactory deficits could compromise performance in this assay as well. Inability to smell or see the novel objects may cause disinterest
or inability to establish a specific pattern, leading to data suggesting that a mouse does not display higher-order repetitive behaviors. Some
inbred strains (albino strains in particular) have clearly compromised visual acuity, especially at advanced ages. This did not appear to influence
behavior in this testing, as adult FVB and C57 mice (an albino and pigmented strain, respectively) showed no consistent differences in
behavior (Figures 2 and 3). However, any impairments or abnormalities in either vision or olfaction could reasonably be expected to affect the
performance of the mouse strain in this assay and screening for basic sensory ability would be recommended for any new strain utilized in the
novel object exploration assay.

RRBs often emerge early in childhood of affected individuals, and as such, an assay that could measure the presence of higher-order RRBs in
young mice would be beneficial for establishing face and construct validity of potential mouse models. To date, this assay has only been used
on adult mice. Novel object exploration may be difficult for younger mice as they have difficulty moving independently prior to approximately
postnatal day 10. Additionally, mice younger than postnatal day 14-16 may be hesitant to move in novel arenas. Scaling down the size of the
testing arena used here and making the arena more familiar (by using a home cage, for example) might ameliorate some of these issues, but it is
unclear if this novel object exploration assay is appropriate for testing younger mice.

One potential set of statistical analyses was discussed here. Given the unique nature of the sequencing data this assay generates, it is entirely
possible that alternative analytical strategies might reveal additional information that this relatively simple approach did not uncover. The
representative data that was analyzed and included here showed modest evidence of patterned exploratory behaviors as female C58 mice
showed greater repetition in the circular testing arena (Figure 2A). There was no evidence to suggest any increase in repetition levels of the
C58 in the rectangular arena (Figure 2C), as well as no evidence that males demonstrated any pattern in either arena (Figure 2B, 2D). There
is currently no explanation for the difference in behaviors between the male and female test subjects. A possible explanation could be the
inherent behaviors of this mouse strain. It has been found that male C58 tend to display more repetitive and anxious behaviors than their female
counterparts11. This difference in anxious behaviors could lead to less interest in forming a preference for a specific object and more of an
interest in simply exploring these potentially anxiety inducing novel objects. It is entirely possible that other mouse strains may also show sex
differences in this assay.

Both male and female C58 mice showed specific object preference within the circular testing arena as they revisited their preferred novel object
more often as well as visited their least preferred object significantly less often than the other strains (Figure 3A, 3B). The C58 strain also
displayed preference for one object over the other in the circular arena, but not in the rectangular arena (Figure 3C, 3D). This is likely due to
some salient feature of the round testing arena such as the lack of corners, the larger surface area available for exploration or the increased
distance of the objects from the walls. Future work on this assay should investigate the effects of these variables on mouse exploration.

The primary focus here has been on higher-order repetitive behaviors, but given that all behaviors in the novel object assay are video recorded,
it is also possible to measure other behaviors. Lower-order repetitive behaviors such as rearing, jumping, grooming and digging are commonly
seen in open field assays such as this one. With some mice, these behaviors may compete with the presence of higher-order repetitive
behaviors and would be important to measure and quantify during both the acclimation and testing period.

Despite the fact that only two studies using novel object exploration in mice have been published to date17,22, this assay has the potential to fill an
existing need for an assay that measures higher-order repetitive behavior quickly and with minimal confounding variables. Such an assay would
nicely complement existing tests of higher order RRBs such as hole-board exploration and reversal learning. RRBs are a core feature of ASD
and potentially debilitating for the lives of affected individuals. Validated mouse models for lower- and higher-order RRBs would be extremely
valuable for testing potential pharmacological and behavioral interventions. The novel object exploration assay described here has the potential
for serving a very important need in basic biomedical research.
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